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Section Marks : 35

Mark As Answered Required? : Yes
Sub-Section Number : 1
Sub-Section Id : 899514125
Question Shuffling Allowed : Yes

Question Number : 1 Question Id : 8995147707 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

GIMP is an image editing tool.

1. Open Source

2. Proprietary

3. Shareware

4. Both (1) and (2)

Options :

89951430458. 1
89951430459. 2
89951430460. 3
89951430461. 4

Question Number : 2 Question Id : 8995147708 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

The tool allows you to select a drawing with the free-hand.

Fuzzy Selection
Lasso
Text

Bucket Fill
Options :

W N e



89951430462. 1
89951430463. 2
89951430464. 3
89951430465. 4

Question Number : 3 Question Id : 8995147709 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

helps you to add a new layer to the image which is identical copy of

the active layer.

1. Smudge Tool

2. Dodge Tool

3. Perspective Tool
4. Duplicate Layer

Options :

89951430466. 1
89951430467. 2
89951430468. 3
89951430469. 4

Question Number : 4 Question Id : 8995147710 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



In mode, the selection is shown as a translucent screen overlying the

image, whose transparency at each pixel indicates the degree to which that pixel is
selected.

. Default
. Quickmask
. Marching Ants

BW N e

. Normal

Options :

89951430470. 1
89951430471. 2
89951430472. 3
89951430473. 4

Question Number : 5 Question Id : 8995147711 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Shift + C is the shortcut to the image.

1. Duplicate

2. Delete

3. Copy

4. Crop
Options :
89951430474. 1
89951430475. 2

89951430476. 3
89951430477. 4



Question Number : 6 Question Id : 8995147712 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

are the transparent sheets stacked one on top of the other.

Layers
Canvas
Windows

=2 W N =

None of the above
Options :

89951430478. 1

89951430479. 2

89951430480. 3
89951430481. 4

Question Number : 7 Question Id : 8995147713 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Scale option is used to change the of an image.

Colour

Size

Area

. All of the above

B W N =

Options :

89951430482. 1
89951430483. 2
89951430484. 3
89951430485. 4

Question Number : 8 Question Id : 8995147714 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No



Correct Marks : 1 Wrong Marks : 0
By default the extension of GIMP file is

.png
. .Jpg
xcf

. Ltiff
Options :
89951430486. 1
89951430487. 2
89951430488. 3
89951430489. 4

Question Number : 9 Question Id : 8995147715 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

What does selecting a layer mode do?

. Copies the layers to all the other layers

Locks the layer so that it can’t be changed

. Changes the appearance of the layer or image based on underlying layers
. Temporarily hides the layer from view

W N =

Options :

89951430490. 1
89951430491. 2
89951430492. 3
89951430493. 4

Question Number : 10 Question Id : 8995147716 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Distort filters are used to do what to an image

1. Create special effects

2. Fix out of focus images

3. Remove atmospheric distortion

4. Correct hues created by color filters

Options :

89951430494. 1
89951430495. 2
89951430496. 3
89951430497. 4

Question Number : 11 Question Id : 8995147717 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Transparency can be completely eliminated by

Adding an alpha channel
. Adding a Layer Mask
. Semi flattening the image

B wWwN =

. Removing the alpha channel

Options :

89951430498. 1
89951430499. 2
89951430500. 3
89951430501. 4

Question Number : 12 Question Id : 8995147718 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



How do you start the Paths tool?

Select the relevant icon in the toolbox
Use Tools 2 Paths from the image menu
Use the hotkey B

All of these are correct

il o

Options :

89951430502. 1
89951430503. 2
89951430504. 3
89951430505. 4

Question Number : 13 Question Id : 8995147719 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

How can you access help for an unfamiliar tool?

Select the help files index
Read the manual
Hover the mouse over the tool and press F1

2 W N =

Search the internet

Options :

89951430506. 1
89951430507. 2
89951430508. 3
89951430509. 4

Question Number : 14 Question Id : 8995147720 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



What purpose does the alpha channel serve?

Encodes information about layer transparency
It is the first channel in an image
Tells all the other layers what color to be

W N e

Sets the color index for every layer
Options :

89951430510. 1

89951430511. 2

89951430512. 3

89951430513 4

Question Number : 15 Question Id : 8995147721 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

What tool do you use to trim unwanted information from a photo?

Use the Eraser

1.

2. Use the Resize button
3. Use the Crop Tool
4.

Use the Trim tool
Options :
89951430514. 1
89951430515. 2
89951430516. 3
89951430517. 4

Question Number : 16 Question Id : 8995147722 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



How are palettes accessed in GIMP?

By using the Palettes dialog
. By typing Palettes with the keyboard
There are no palettes in GIMP

By clicking the Paths dialog
Options :

89951430518. 1

89951430519. 2

89951430520. 3

89951430521. 4

=2 W N =

Question Number : 17 Question Id : 8995147723 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Why does the shape of the cursor change when inside the image window?

To blend in with the image
To stand out from the image
To make it easier to see

Bown e

. To indicate which tool is active

Options :

89951430522. 1
89951430523. 2
89951430524. 3
89951430525. 4

Question Number : 18 Question Id : 8995147724 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



What happens to the Undo History when an image is closed?

1. Itis saved as a separate file

2. ltis deleted

3. Itis saved as a series of images

4, Itis saved into the image metadata
Options :

89951430526. 1

89951430527. 2

89951430528. 3
89951430529. 4

Question Number : 19 Question Id : 8995147725 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

In a JPEG file, what happens if image compression is increased?

1. You have to use a decompressor to open the file
2. The file takes up more space

3. Image quality decreases

4. It takes longer to open the file

Options :

89951430530. 1

89951430531. 2

89951430532. 3
89951430533. 4

Question Number : 20 Question Id : 8995147726 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



What must you do to use an image produced in GIMP in another program?

1. Copy the file to the other program’s folder

2. You cannot use GIMP images in other programs
3. All programs support GIMP native format

4. Export a file format that the program can use
Options :
89951430534. 1
89951430535. 2

89951430536. 3
89951430537. 4

Question Number : 21 Question Id : 8995147727 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

What tools may be used to paint on a Quick Mask?

1. Only the Brush tool

2. Any drawing tool and the Bucket Fill tool
3. Only the eraser

4. Only the pencil tool

Options :

89951430538. 1

89951430539. 2

89951430540. 3
89951430541. 4

Question Number : 22 Question Id : 8995147728 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



How to specify which portion of an image you want to modify?

1. Use the View Selection command

2. Draw ared circle around it

3. Use the Selection tools

4. Cut and paste the part you want into a new image
Options :

89951430542. 1

89951430543. 2

89951430544. 3
89951430545. 4

Question Number : 23 Question Id : 8995147729 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

The Fuzzy Select (Magic Wand) tool helps you to select areas of the

Canvas

. All the layers

. Current layer

. Image with different colors

B WN =

Options :

89951430546. 1
89951430547. 2
89951430548. 3
89951430549. 4

Question Number : 24 Question Id : 8995147730 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Preparing the image for the web means

Reducing the size of an image
. Zipping the image

. Crop the image

. All of the above

-FIUJM!-"

Options :

89951430550. 1
89951430551. 2
89951430552. 3
89951430553. 4

Question Number : 25 Question Id : 8995147731 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

It is the most important part of the image where the image is displayed

1. Canvas

2. Window
3. Scale

4. Bucket Fill
Options :
89951430554. 1
89951430555. 2

89951430556. 3
89951430557. 4

Question Number : 26 Question Id : 8995147732 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Which file format offers the best image compression?

1. .bmp

2. .png

3. .jpg

4. None of these
Options :
89951430558. 1
89951430559. 2

89951430560. 3
89951430561. 4

Question Number : 27 Question Id : 8995147733 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

What is the shortcut key combination in GIMP, to rotate an image?

. Shift+C
Shift + F
Shift + R
Shift +T
Options :
89951430562. 1
89951430563. 2

89951430564. 3
89951430565. 4

=W N =

Question Number : 28 Question Id : 8995147734 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Which mode is used for image file, when file size is of concern, or when you are working
with images?

Indexed
Greyscale
RGB

. None of these

W N

Options :

89951430566. 1
89951430567. 2
89951430568. 3
89951430569. 4

Question Number : 29 Question Id : 8995147735 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0
Which tool lets you select a freehand border and uses edge-recognition algorithms to
better fit the border around the object?

Scissor Select tool

Intelligent Scissor Select tool
Select tool

. Intelligent Select tool

B W N =

Options :

89951430570. 1
89951430571. 2
89951430572. 3
89951430573. 4



Question Number : 30 Question Id : 8995147736 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

What is the shortcut key combination in GIMP, to scale an image?

Shift + T
Shift + R
Shift + F

. Shift+C
Options :
89951430574. 1
89951430575. 2
89951430576. 3
89951430577. 4

B WN e

Question Number : 31 Question Id : 8995147737 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

What is the shortcut key combination in GIMP, to flip an image?

Shift + C
Shift + R
. Shift+F
. Shift+ A
Options :
89951430578. 1
89951430579. 2

89951430580. 3
89951430581. 4

W N

Question Number : 32 Question Id : 8995147738 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No



Correct Marks : 1 Wrong Marks : 0

Which value of the resolution under print size for an image, results in very high

300 ppi
100 ppi
200 ppi
None of these

AWN R

Options :

89951430582. 1
89951430583. 2
89951430584. 3
89951430585. 4

Question Number : 33 Question Id : 8995147739 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

What is the use of cropping an image?

. Fitting an image to fill an frame
Emphasize the subject

Removing a portion of the background
. All of these

Options :

89951430586. 1
89951430587. 2
89951430588. 3
89951430589. 4

=W N

Question Number : 34 Question Id : 8995147740 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



What is the default mode for image file in GIMP?

1. Indexed

2. Greyscale

3. RGB

4. None of these
Options :

89951430590. 1
89951430591. 2
89951430592. 3
89951430593. 4

Question Number : 35 Question Id : 8995147741 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

What does the character “G” expands to in GIMP

1. General
2. Generic
3. Grep

4. GNU
Options :

89951430594. 1
89951430595. 2
89951430596. 3
89951430597. 4

GOOGLE SKETCHUP

Section Id : 899514104



Section Number : 2

Section type : Online
Mandatory or Optional : Mandatory
Number of Questions : 30
Number of Questions to be attempted : 30

Section Marks : 30

Mark As Answered Required? : Yes
Sub-Section Number : 1
Sub-Section Id : 899514126
Question Shuffling Allowed : Yes

Question Number : 36 Question Id : 8995147742 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Google SketchUp Keeps

Three windows
Five windows

Four windows

W N

One window

Options :

89951430598. 1
89951430599. 2
89951430600. 3
89951430601. 4

Question Number : 37 Question Id : 8995147743 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Z-Axis Indicates

1. Height
2. Length
3. Breadth

4. Depth

Options :

89951430602. 1
89951430603. 2
89951430604. 3
89951430605. 4

Question Number : 38 Question Id : 8995147744 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Which is the Open Source Software

1. Google SketchUp Make
2. Google SketchUp Free
3. Google SketchUp Pro

4. Google SketchUp

Options :

89951430606. 1
89951430607. 2
89951430608. 3
89951430609. 4

Question Number : 39 Question Id : 8995147745 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Use of Orbit Tool to Rotate

1. Side of a Model
2. Top of a Model
3. Complete Model
4. All Axis

Options :

89951430610. 1
89951430611. 2
89951430612. 3
89951430613. 4

Question Number : 40 Question Id : 8995147746 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Eraser Tool Effects

1. X-Axis
2. Y-Axis
3. Edges of a Model
4, Surface of a Model
Options :
89951430614. 1
89951430615. 2

89951430616. 3
89951430617. 4

Question Number : 41 Question Id : 8995147747 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Push/Pull Tool Works on

1. Curved lines

2. State Lines

3. Flat Shape

4. Smoothed Surface
Options :

89951430618. 1
89951430619. 2
89951430620. 3
89951430621. 4

Question Number : 42 Question Id : 8995147748 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Which Key is to be Hit for Copying a Shape

Alt Key
Tab Key
Ctrl Key
Shift Key
Options :
89951430622. 1
89951430623. 2

89951430624. 3
89951430625. 4

BwoNop

Question Number : 43 Question Id : 8995147749 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Rotate Tool works for

1. Stretch

2. Copy

3. Array

4. All of these
Options :

89951430626. 1
89951430627. 2
89951430628. 3
89951430629. 4

Question Number : 44 Question Id : 8995147750 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

We can Create a Sphere with the help of

1. Triangle and Circle
2. Cube and Circle

3. With two circles

4. Rectangle and Circle
Options :

89951430630. 1
89951430631. 2
89951430632. 3
89951430633. 4

Question Number : 45 Question Id : 8995147751 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Which Tool is Needed for Creating Sphere

1. Rotate Tool

2. Eraser Tool

3. Offset Tool

4. Follow Me Tool
Options :
89951430634. 1
89951430635. 2

89951430636. 3
89951430637. 4

Question Number : 46 Question Id : 8995147752 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Move Tool works for

1. Stretch

2. Copy

3. Array

4, All of these
Options :

89951430638. 1
89951430639. 2
89951430640. 3
89951430641. 4

Question Number : 47 Question Id : 8995147753 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Follow Me tool requires

1. a profile shape and a path

2. only ashape

3. Only a Path

4. No Path and Shape is required

Options :

89951430642. 1
89951430643. 2
89951430644. 3
89951430645. 4

Question Number : 48 Question Id : 8995147754 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Pan Tool is Needed for Moving

1. Surface of a Model
2. Axis of Screen

3. Complete Model
4. Menu Bar

Options :

89951430646. 1
899514300647. 2
89951430648. 3
89951430649. 4

Question Number : 49 Question Id : 8995147755 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



To Increase the Segments of a Circle

1. Hold the Shift Key and Hit the + key

2. Hold the Control Key and Hit the +Key
3. Hold the Alt Key and Hit the +Key

4. Only Hit the +key again and again
Options :

89951430650. 1
89951430651. 2
89951430652. 3
89951430653. 4

Question Number : 50 Question Id : 8995147756 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Offset Tool works for Copying

1. A Model

2. Edgesin aPlane
3. Optional Bar

4, Axis
Options :

89951430654. 1
89951430655. 2
89951430656. 3
89951430657. 4

Question Number : 51 Question Id : 8995147757 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



To Stand a lying Shape Vertical, we use

1. Move Tool
2. Rotate Tool
3. Offset Tool
4. Camera Tool
Options :

89951430658. 1
89951430659. 2
89951430660. 3
89951430661. 4

Question Number : 52 Question Id : 8995147758 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Which is Editing Tool

1. Line Tool
2. Two point Arc Tool
3. Move Tool

4, Freehand Tool
Options :

89951430662. 1
89951430663. 2
89951430664. 3
89951430665. 4

Question Number : 53 Question Id : 8995147759 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Which is Drawing Tool

1. Polygon Tool
2. Scale Tool
3. Pan Tool

4. Orbit Tool
Options :
89951430666. 1
89951430667. 2
89951430668. 3
89951430669. 4

Question Number : 54 Question Id : 8995147760 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Which are Principal Tools

1. OrbitTool

2. SelectTool

3. Tape Measure Tool
4. Protector Tool
Options :

89951430670. 1
89951430671. 2
89951430672. 3
89951430673. 4

Question Number : 55 Question Id : 8995147761 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Location of Measurement Box is

Top Right of the Screen
Top Left of the Screen
Bottom Right of the Screen
Bottom Left of the Screen

:hUJ!‘UI—'i

Options :

89951430674. 1
89951430675. 2
89951430676. 3
89951430677. 4

Question Number : 56 Question Id : 8995147762 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Which are Camera Tools

Pan Tool
Protector Tool
Scale Tool

Shadow tool
Options :
89951430678. 1
89951430679. 2
89951430680. 3
89951430681. 4

B W N R

Question Number : 57 Question Id : 8995147763 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



A Polygon Have

1. 6 Sides
2. 8 Sides
3. 7 Sides
4. 9 Sides
Options :

89951430682. 1
89951430683. 2
89951430684. 3
89951430685. 4

Question Number : 58 Question Id : 8995147764 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

A Circle Have

1. 12 Sides
2. 15 Sides
3. 24 Sides
4. 18 Sides
Options :

89951430686. 1
89951430687. 2
89951430688. 3
89951430689. 4

Question Number : 59 Question Id : 8995147765 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



An Arc Have

1. 6 S5egments
2. 12 Segments
3. 15 Segments
4, 18 Segments
Options :

89951430690. 1
89951430691. 2
89951430692. 3
89951430693. 4

Question Number : 60 Question Id : 8995147766 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Selection Tool Selects Whole Model by

1. Single Click
2. Double Click
3. Triple Click
4. Four Click
Options :

89951430694. 1
89951430695. 2
89951430696. 3
89951430697. 4

Question Number : 61 Question Id : 8995147767 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Which is Construction Tool

1. Tape Measure Tool
2. Walk Tool

3. Look Around Tool
4. Paint Tool

Options :

89951430698. 1
89951430699. 2
89951430700. 3
89951430701. 4

Question Number : 62 Question Id : 8995147768 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Walk Tool is a

1. Construction Tool
2. Shadow Tool

3. Edit Tool

4, Camera Tool
Options :

89951430702. 1
89951430703. 2
89951430704. 3
89951430705. 4

Question Number : 63 Question Id : 8995147769 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Follow Me Tool is a

1. Drawing Tool
2. View Tool

3. Edit Tool

4. Principal Tool
Options :

89951430706. 1
89951430707. 2
89951430708. 3
89951430709. 4

Question Number : 64 Question Id : 8995147770 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

We Can Paint a House with

1. Construction Tool
2. Edit Tool

3. Paint Tool

4, Shadow Tool
Options :

89951430710. 1
89951430711. 2
89951430712. 3
89951430713. 4

Question Number : 65 Question Id : 8995147771 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Paint Bucket is a

1. Edit Tool
2. Drawing Tool
3. Measurement Tool

4. Principal Tool
Options :
89951430714. 1
89951430715. 2
89951430716. 3
89951430717. 4

Section Id :

Section Number :
Section type :
Mandatory or Optional :
Number of Questions :

Number of Questions to be attempted :

Section Marks :

Mark As Answered Required? :

Sub-Section Number :
Sub-Section Id :
Question Shuffling Allowed :

Question Number : 66 Question Id : 8995147772 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

BLENDER

899514105
3

Online
Mandatory
35

35

35

Yes

1
899514127
Yes



How one can add a Mesh in blender?

1. Shift A > Mesh

2. Shift A >Metaball
3. Ctrl A > Curve

4. Shift +Ctrl A >Mesh
Options :

89951430718. 1
89951430719. 2
89951430720. 3
89951430721. 4

Question Number : 67 Question Id : 8995147773 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Press N to open ...... in Blender.

1. Render window
2. Outliner

3. Properties Region
4, Tool Shelf

Options :

89951430722. 1
89951430723. 2
89951430724. 3
89951430725. 4

Question Number : 68 Question Id : 8995147774 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Cycles is name assigned to in blender

1. Painting tool

2. Render engine
3. Camera tracker
4, Sculpting tool
Options :

89951430726. 1
89951430727. 2
89951430728. 3
89951430729. 4

Question Number : 69 Question Id : 8995147775 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

To scale across “Y” axis the shortcut is

SHIFT +Y
CTRL+Y

S(KEY) + Y

4. SHIFT+ CTRL+Y

W N

Options :

89951430730. 1
89951430731. 2
89951430732. 3
89951430733. 4

Question Number : 70 Question Id : 8995147776 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



How you can work with laptop (1 to 0) keys instead of using a numpad based keyboard

File> User Preference> Input> Emulate Numpad
File>User Preference>Interface> Emulate Numpad
Edit> User Preference>Input> Emulate Numpad
Edit> Add-ons>Input> Emulate Numpad

Options :

89951430734. 1

89951430735. 2

89951430736. 3
89951430737. 4

pwN e

Question Number : 71 Question Id : 8995147777 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

The modifier allows easy application of a simple deformation to an object

Subdivision Surface
Solidify

Simple Deform Modifier
Simple Deform

B WN =

Options :

89951430738. 1
89951430739. 2
89951430740. 3
89951430741. 4

Question Number : 72 Question Id : 8995147778 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



For dealing with noise/fireflies in blender, one may use

1. Subdivision Surface
2. Denoising

3. Solidify

4. Loop Cuts

Options :

89951430742. 1
89951430743. 2
89951430744. 3
89951430745. 4

Question Number : 73 Question Id : 8995147779 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

The tool creates a cut through the whole loop you select, generating one or more new
loops

Mirror
Duplicate
Loop cuts
Render

Ll ol ol o

Options :

89951430746. 1
89951430747. 2
89951430748. 3
89951430749. 4

Question Number : 74 Question Id : 8995147780 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Lamp/Light is not supported in cycles render

1. Spot Light
2. Point Light
3. Hemi Light
4. Sun Light
Options :

89951430750. 1
89951430751. 2
89951430752. 3
89951430753. 4

Question Number : 75 Question Id : 8995147781 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

One can modify the faces of mesh in mode

Object Mode
Pose mode
Edit Mode

4, Weight Mode
Options :
89951430754. 1
89951430755. 2
89951430756. 3
89951430757. 4

W N e

Question Number : 76 Question Id : 8995147782 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



In edit mode, press ...... to open Extrude Menu

1. Alt+E

2. Ctrl+W

3. Shift+W

4. Ctrl +E
Options :

89951430758. 1
89951430759. 2
89951430760. 3
89951430761. 4

Question Number : 77 Question Id : 8995147783 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

The shortcut for rendering in blender is

1. F12
2. CTRL+ALT+0
3. SHIFT+F12
4, F3
Options :

89951430762. 1
89951430763. 2
89951430764. 3
89951430765. 4

Question Number : 78 Question Id : 8995147784 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Boolean modifier performs ; , and operations
1. Difference, Union, Intersect

2. Difference, Multiply, Normal

3. Union, Multiply, Difference

4. Intersect, Multiply, Union

Options :

89951430766. 1
89951430767. 2
89951430768. 3
89951430769. 4

Question Number : 79 Question Id : 8995147785 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

With , one can create complex materials in Blender

Loop Cut
Node Cut
Node Editor
Weight mode

PN

Options :

89951430770. 1
89951430771. 2
89951430772. 3
89951430773. 4

Question Number : 80 Question Id : 8995147786 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



“X" key performs the operation of

Join Selected objects, vertices or faces
Delete selected objects, vertices or faces.
Edit two faces

Merge two faces in Edit mode

BN e

Options :

89951430774. 1
89951430775.2
89951430776. 3
89951430777. 4

Question Number : 81 Question Id : 8995147787 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

“Numpad+ period(.)” is used as shortcut for
Go to Selected Object

Camera View
Front View

PN e

Side view

Options :

89951430778. 1
89951430779. 2
89951430780. 3
89951430781. 4

Question Number : 82 Question Id : 8995147788 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



For Reset 3D Cursor the shortcut in blender is

1. Shift+C

2. Ctrl+C

3. Shift+ Ctrl + C
4. Alt+Ctrl+C
Options :

89951430782. 1
89951430783. 2
89951430784. 3
89951430785. 4

Question Number : 83 Question Id : 8995147789 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Blender is a

1. Proprietary and paid software

2. Licensed and paid software

3. Free and open source 3D software
4. 2D and open source software
Options :

89951430786. 1
89951430787. 2
89951430788. 3
89951430789. 4

Question Number : 84 Question Id : 8995147790 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



The first large professional project in which the free version of Blender used

Elephants Dream
Spider-Man 2
Big Buck Bunny
Batman

BN

Options :

89951430790. 1
89951430791. 2
89951430792. 3
89951430793. 4

Question Number : 85 Question Id : 8995147791 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

is an open source video game made by the Blender Institute

1. Yo Frankie

2. Plumiferos

3. Sintel

4, Tears of Steel
Options :

89951430794. 1
89951430795. 2
89951430796. 3
89951430797. 4

Question Number : 86 Question Id : 8995147792 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



the default renderer of Blender

Cycles Render
Blender Render
Blender Game
LuxRender

BN e

Options :

89951430798. 1
89951430799. 2
89951430800. 3
89951430801. 4

Question Number : 87 Question Id : 8995147793 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Blender Supports

1. Linux, Windows, and Macintosh systems
2. Windows, Android and Macintosh systems
3. Linux, Android and Macintosh systems

4. Linux, Android and Unix systems

Options :

89951430802. 1
89951430803. 2
89951430804. 3
89951430805. 4

Question Number : 88 Question Id : 8995147794 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Shortcut to switch the view to the camera one is

Ctrl+ C
R key

0 key
4. Skey
Options :
89951430806. 1
89951430807. 2

89951430808. 3
89951430809. 4

W N

Question Number : 89 Question Id : 8995147795 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

The part of a mesh where three or more vertices are joined together by edges is known as

1. Edges

2. Vertices
3. Nurbs
4. Faces
Options :

89951430810. 1
89951430811. 2
89951430812. 3
89951430813. 4

Question Number : 90 Question Id : 8995147796 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Red, Green, and Blue widget that appears with the Active Object is known as

1. Transform Manipulator
2. 3d Cursor

3. World Grid

4. World Nurbs

Options :

89951430814. 1
89951430815. 2
89951430816. 3
89951430817. 4

Question Number : 91 Question Id : 8995147797 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

To make An Edge Loop Selection one should

1. Press the SHIFT key and Right Mouse Button on the edge that needs to be selected.
2. Press the ALT key and Left Mouse Button on the edge that needs to be selected.

3. Press the SHIFT key and Left Mouse Button on the edge that needs to be selected.
4. Press the ALT key and Right Mouse Button on the edge that needs to be selected.
Options :

89951430818. 1
89951430819. 2
89951430820. 3
89951430821. 4

Question Number : 92 Question Id : 8995147798 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Perpendicular line drawn from out of the center of a face that represents the direction the face is
pointing is known as

1. Nurb

2. Normal
3. Edge

4. Face
Options :

89951430822. 1
89951430823. 2
89951430824. 3
89951430825. 4

Question Number : 93 Question Id : 8995147799 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

For Making a border selection one should

1. Pressthe B key on the 3D view, left click to start the selection and release to confirm it.

2. Press the Ctrl+B key on the 3D view, left click to start the selection and release to confirm it.
3. Press the shift+B key on the 3D view, right click to start the selection and release to confirm it.
4. Press the B key on the 3D view, right click to start the selection and release to confirm it.
Options :

89951430826. 1
89951430827. 2
89951430828. 3
89951430829. 4

Question Number : 94 Question Id : 8995147800 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



An Armature is a

A Mesh in Rest Position

The skeletal structure in rest position
A monkey head

A mesh in moving position

BwN e

Options :

89951430830. 1
89951430831. 2
89951430832. 3
89951430833. 4

Question Number : 95 Question Id : 8995147801 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Mesh Editing is used for

1. Manipulating the data of a mesh, or polygon-based object.
2. Adding a mesh, or polygon-based object.

3. Rotating a mesh, or polygon-based object.

4. Scaling a mesh, or polygon-based object.

Options :

89951430834. 1
89951430835. 2
89951430836. 3
89951430837. 4

Question Number : 96 Question Id : 8995147802 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Lines of connection between interconnected vertices are known as

Face
Vertex
Edge
Nurb
Options :
89951430838. 1
89951430839. 2

89951430840. 3
89951430841. 4

BN

Question Number : 97 Question Id : 8995147803 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

is used to Extrude a Selected Face

Press the E key to extrude a selected face
Press the shift + E key to extrude a selected face
Press the O key to extrude a selected face
Press the S key to extrude a selected face

Bwnp

Options :

89951430842. 1
89951430843. 2
89951430844. 3
89951430845. 4

Question Number : 98 Question Id : 8995147804 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



Single points in 3D space that form the basis of a mesh is known as

Face
Vertex
Edge
Nurb
Options :
89951430846. 1
89951430847. 2

89951430848. 3
89951430849. 4

BN

Question Number : 99 Question Id : 8995147805 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0

Moeodifiers in blender are used for

1. Modify a mesh or other object in some way.
2. Scaling a mesh or other object in some way.
3. Adding a mesh, or polygon-based object.

4. Rotating a mesh, or polygon-based object.
Options :

89951430850. 1

89951430851. 2

89951430852. 3
89951430853. 4

Question Number : 100 Question Id : 8995147806 Question Type : MCQ Option Shuffling : No Is Question Mandatory : No
Correct Marks : 1 Wrong Marks : 0



The shortcut for Duplicating Selected 3d Object in blender is

1. Shift+D

2. Ctrl+5S

3. Shift+Ctrl+D
4. Ctrl+P

Options :

89951430854. 1
89951430855. 2
89951430856. 3
89951430857. 4



